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Executive Summary 
A year ago, the question everybody was asking was ―When are you migrating to Office 2010 or 2007?‖ 

The emerging questions are: 

 ―How much of Office 2010 or 2007 will you take advantage of?‖ 

 ―How will you arm your users to cope with a dual-format environment?‖ 

No aspect of this upgrade can be taken lightly; it may impact everything—hardware, operating system, 

DMS Client, CRM desktop, third-party templates, precedent libraries, forms, automation, email and the 

myriad add-ins deployed, and not to mention, training needs. Beyond the usual project concerns, there 

are also risks inherent in the conversion of the documents. 

Fundamental to achieving the full range of benefits this upgrade has to offer is the adoption of 

Microsoft™ Word’s .docx (OpenXML) format. However, the only way you can get there is by providing a 

predictable path that is easily accessible and seamless to your users. This ensures they can quickly 

navigate the firm’s templates, styles and DMS workflows moving you safely out of Word’s .doc (binary) 

format. 

The purpose of this paper is to inform you about the impact your file format choice has on your 

users and client relationships; then to provide you with recommendations to make the move 

safely with a minimum amount of risk to firm reputation. You are juggling a lot of moving parts 

and pieces; be careful not to overlook the considerations and ramifications of the .docx format.  

The last major move as significant as the migration to the .docx format was the upgrade from 

WordPerfect. Although there are some similarities, enough differences exist that you cannot just repeat 

the process. You need a new, comprehensive plan for managing the existence of dual file formats.  

In this white paper, you will learn: 

 Why you need to consider the .docx format 

 When to time your move to the .docx format 

 How to handle precedent, boilerplate and ―top-drawer‖ or model documents 

 How to avoid content loss and unwanted formatting changes even before the move 

 What steps you can take to ensure client service isn’t negatively affected 

Conclusion 
Like all upgrades, there are risks and rewards to the move. In this case, you are impacted by the change in 

file format whether or not your firm migrates. Currently, Microsystems has uncovered at least 14 scenarios 

that affect content or user experience in documents traveling from .doc to .docx. Failure to understand the 

firm’s exposure to these risks, and to institute processes for preventing and resolving them could 

negatively affect client service.  
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Why You Need to Plan for the .docx Format 
Your firm decided to upgrade to Office 2010 or 2007. You know you need to upgrade equipment, 

applications and training strategies, but why is everyone talking about the .docx format and why is it so 

important?  

.docx Is Becoming the New Norm 
According to ILTA’s 2010 Technology Survey, 22% of firms have already moved to Office 2007 and by the 

end of 2012 another 75% plan to move to Office 2010, as shown in Figure 1. Momentum is building in the 

industry, spurred by pressure from expiring technology, your peers and your clients. Couple that with your 

users upgrading to or purchasing home computers with Office 2010 or 2007; legacy versions of Office 

nearing end of support and you can see that the prevalence of OpenXML files continues to grow. In fact, 

51% of firms migrated to Office 2010 or 2007 report standardizing on the OpenXML file formats. 

 

Figure 1 Adoption of Microsoft Word 2007 as a law firm's primary word processer, according to the ILTA 

Technology Survey 

The .docx Format Is Better 
The new .docx format is a tremendous improvement over the old .doc format. The most obvious 

improvement is the reduced file size, but the new format is also less prone to corruption, making it more 

stable. The .docx document cannot contain macros, so security is improved. Also, it is easier to develop 

integration with one part of a document without affecting the entire document. For example, a standard 

footer can be inserted into the document without a risk of corrupting the remainder of the document. 

Furthermore, corruption in one part of a document does not prevent the user from opening and accessing 

the document. See Appendix A for detailed benefits. 

2008 ILTA 
Technology 

Survey 

4% Use Word 
2007 

2009 ILTA 
Technology 

Survey 

11% Use 
Word 2007 

2010 ILTA 
Technology 

Survey 

22 % Use 
Word 2007 

2012 ILTA 
Technology 

Survey* 

75% Use 
Word 

2007/2010 

*Projected rate of migration to Office 2007/2010 
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“There is no reason to continue to set the default file type for new 

documents to .doc when upgrading to Office 2010 or 2007, but 

attorneys should make it a point to be aware of which file type their 

clients are using” explained Kris Kim, Applications Analyst, Gibson, 

Dunn & Crutcher  LLP. “The .docx format is more stable, easier to 

troubleshoot, has more features and on the whole uses less space in 

the DMS.”  

The Risks Are High 
Microsoft provides methods of upgrading a document to .docx or downgrading a document to .doc. 

Commonly referred to as the Compatibility Pack or the Compatibility Mode, it delivers a surprising level of 

transformation. However, there are risks in using this method. Because it was built in the lab as opposed 

to the real world, it cannot cater to all known issues in legacy documents that are now flowing to the new 

format. 

In 2006, Microsystems began to experience strange behaviors in automatic paragraph numbering as we 

were working with one of our first clients to move to Office 2007. We engaged with Microsoft to better 

understand and resolve the issue. A solution for this problem was release by Microsoft in 2010. Because of 

this experience, we decided to test the movement of documents between the dual formats. 

Microsystems analyzed over 25,000 documents and found document- or user-affecting issues were 

created when upgrading a .doc document to .docx using native Word capabilities. These issues fall into 

one of three categories, but all of them may frustrate users or perplex clients. Even if your firm resolves 

the issues before the document is presented to the client, the delays incurred dealing with the issues may 

impact delivery time and therefore may negatively impact client satisfaction. 

The issues we found include: 

 Lost numbering 

 Formatting or pagination changes 

 Altered user experience 

Lost Numbering 
On average, over 5% of documents and in several cases up to 15% of documents had 

corrupt numbering such that when they were upgraded to .docx, the numbering would be 

removed from the document in an aggressive attempt to “fix” the corruption. In other 

words, your firm may work on a .doc document, save it as a .docx file and everything looks 

fine. When the client opens the file, all of the numbering on the document may be lost. 

The client service challenge with this problem is that the numbering loss was not noticeable until the 

document was closed and re-opened; unfortunately the first person to re-open the document may be the 

client. 
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Figure 2 Example of a .doc document that contains corrupt numbering. 

 

Figure 3 Example of numbering loss when the document in Figure 2 was saved as a .docx. 

Formatting, Spacing or Pagination Changes 
We found over 57% were at risk of formatting, spacing or pagination changes due to 

compatibility settings prior to Word 2003. Another 31% had custom compatibility settings 

such as those used for California Pleadings and other unique document layout 

requirements. 

Styles and various settings tell Word how to behave and display formatting and spacing correctly. These 

settings exist because each version of Word is different in how it lays out text, tables and graphics. 

WordPerfect documents opened in Word acquire 

specific compatibility settings as well.  

Before discussing compatibility settings further, it 

is important to note that there is a difference 

between compatibility settings and the .docx 

format. 

Compatibility settings control layout (See Figure 4): 

a document can be in the Word 2010 .docx format, 

but retain compatibility settings from Office 95. 

These compatibility settings mean that Word 

should interpret the layout of this document as if it 

was still being viewed in Word 95, which had 

different rules regarding how to display the 

contents of a document. That document is not 

considered to be ―in compatibility mode‖ (.doc 

format). Instead, it is just displaying the contents 

using Word 95 settings, yet still in the .docx 

format. 

When using native Word functionality (―Save As‖ 

or ―Convert‖) to upgrade a document to .docx, the 

 
Figure 4 Example of Word 6.0/95 Compatibility 

Settings 
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document format is changed and the compatibility is set to Word 2010 or 2007, depending on the version 

used to upgrade the .doc. Along with that upgrade, the document formatting, spacing and pagination 

may change. 

While upgrading documents to current compatibility appears to be a good practice, it may in fact cause 

unwanted results. For documents like California Pleadings (see Figure 5) that require specific line spacing, 

this is a serious problem. For documents that are in the eleventh hour of negotiations, these changes may 

disrupt the process. However, for documents in the initial stage of re-use and undergoing a lot of editing, 

the pagination, formatting and spacing changes may be acceptable as the author can re-format any 

undesired changes. Either way, when upgrading compatibility, the process should be controlled and not a 

result of an inadvertent action. Unfortunately, in Word 2007 and earlier, native Word does not provide an 

option; in Word 2010 the option to preserve layout when converting to the .docx format is not intuitive. 

 

Figure 5 Example of a California Pleading upgraded from .doc to .docx with changes to line spacing. 

Altered User Experience 
50% of the documents we analyzed may present an altered user experience due to the 

presence of style aliases. 

The introduction of the Quick Style Gallery in Word 2010 and 2007 provides mouse users with an easy-to-

use method of applying styles (shown in Figure 6). 

 

Figure 6 Word 2010/2007 Quick Style Gallery displaying standard styles. 

However, style aliases, widely used as a keyboard shortcut in legal document production, appear in the 

gallery instead of the Word style name. The practice of using style aliases is primarily born out of 

sophisticated law firms and generally reflects a naming convention understood primarily by the firm that 

created them and only by the users who prefer keyboarding. Unfortunately, the aliases travel with the 

document, which means the client sees them as well. 
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Documents moving from 

person to person and from 

firm to firm may be saved in 

.doc format or .docx format at 

any time. Once the document 

leaves your four walls, all 

control around the file format 

is lost. Users need a process 

for working with both file 

types that is easy and ensures 

predictable document 

behavior. 

The ―everyday‖ user of Word expects to see standard style descriptions in the gallery, not a series of 

letters and numbers. Imagine your client’s confusion when they receive a document and the style gallery 

appears cryptic, as shown in Figure 7. 

 

Figure 7 Word 2010/2007 Quick Style Gallery displaying firm style aliases. 

Safety in Office 2003? Think Again… 
You may choose to delay your upgrade, but you cannot 

ignore the new .docx format. According to the 2010 ILTA 

Technology Survey, 51% of the firms that moved to Office 

2007 are setting their file format default for saving new 

documents to OpenXML, which means your users will 

inevitably see more .docx, .pptx and .xlsx files in their Inbox. 

Do you or your legal teams know what happens when you 

send a .doc document to a client and they save it as .docx? 

The results may not be what your users and their clients 

desire or expect. Documents moving from person to person 

and from firm to firm may be saved in .doc format or .docx 

format at any time. Once the document leaves your four 

walls, all control around the file format is lost.  

Even without an upgrade or a change in your firm’s file 

format, your users will likely be impacted by document 

changes that occur as they move between formats. As you 

prepare for the current reality of living in a dual-format 

environment consider how to provide users with a process 

for working with both file types that is easy and ensures predictable document behavior. 

Relying on clients to have the latest hotfixes or maintain the same file format is risky. A better solution is 

to correct and stabilize documents before they leave the firm, regardless of the file format they are in or 

may travel to.  

The Compatibility Pack Is Not a Solution 
You may think you have the dual format problem solved because everyone uses the Compatibility Pack in 

Word 2003, 2002 and 2000 and they can open and edit OpenXML documents. Unfortunately, there are 

known issues with the Compatibility Pack when trying to open a .docx file in Word 2003, including issues 

that make track changes inoperable and the unnecessary elimination of new and convenient style features 

like Priority, Quick Styles and Visibility. Additionally, not using the Compatibility Pack benefits the 

collaboration process by preserving style settings.  
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Relying on your client’s use of the Compatibility Pack includes the following risks: 

 Client environment may not be up-to-date 

 Document round-tripping introduces additional issues 

 Document exhibits different characteristics in client environment 

 Document requires rework upon return to the firm 

 Chance of eleventh-hour document crisis increases 

It is far better to convert a document up or down using Word 2010 or 2007 than to trust your document 

to the Compatibility Pack. When sending a .docx document to a client that prefers the .doc format, the 

recommended method is to use Word 2010 or 2007 to save the document down to .doc.  

Recommendations 
The migration to Office 2010 or 2007 and the associated change of file format can be managed in a 

practical and safe way without affecting client service or over-burdening users. The following are our 

recommendations for a smooth transition. 

1. Change the Default Format to .docx 
We recommend adopting the OpenXML formats for all Office 2010 or 2007 applications. Working with the 

OpenXML formats in Word, Excel and PowerPoint unleashes the efficiency and productivity benefits of the 

upgrade. However, the adoption of .docx, .xlsx and .pptx does not necessarily need to happen 

immediately or simultaneously. You can defer the file format change until after the rollout is complete or 

you can change the defaults for Excel and PowerPoint without changing the default for Word. See 

Appendix A for advantages of the OpenXML file formats. 

2. Determine the Best Time to Change the Default File Format 
Once you decide to move, a key decision to make is at what point you change the default Save format. 

There are two general deployment strategies for moving from the .doc to the .docx file format:  

 One strategy is to set your default Save as to .docx on Day 1, as soon as you upgrade to Word 2010 

or 2007.  

 The other is to retain the .doc format as the default until the firm is fully migrated; then, using Group 

Policies, change the default Save format to .docx.  The benefits and challenges of these approaches 

are listed in the following table. 



 

    2011 Microsystems, Inc.  All Rights Reserved  P a g e  | 8 

Strategy: Day 1 .docx 

Benefits 

 Users able to leverage all capabilities  

 External collaboration is improved 

 Accelerated adoption of new functionality  

 No future technology or communication 

event is required 

 Proactively manage dual format 

environment   

Challenges 

 Collaboration concerns with internal users 

not yet migrated  

 Initial training program is more extensive  

 Firm is in dual format environment for the 

foreseeable future 

Strategy: Post Migration Switch 

Benefits 

 Reduces internal collaboration challenges 

 Focuses initial training on core functionality  

 Exposure to new functionality occurs only 

when directed by the client 

Challenges 

 Delayed use/ROI of new Office capabilities 

 Training program can become protracted 

 Reactively managing  dual format 

environment driven by clients and external 

documents 

 

Regardless of which approach you choose, your lawyers may experience problems when they receive 

documents from outside of the firm. Assist your lawyers by providing thoughtful workflows and training 

to manage documents within each client’s preferred file format. If the client upgraded to Office 2010 or 

2007, sending them a .docx keeps all features and functionality enabled and provides better client service. 

On the other hand, if the client is still on 2003, sending them a .doc may be more appropriate and reduce 

confusion. 

3. Selectively Convert Documents in the DMS to .docx 
Back when everyone was upgrading from WordPerfect to Word, many firms chose to undertake a bulk 

conversion of their WordPerfect documents to Word due to the lack of compatibility between the two 

platforms. Without WordPerfect on everyone’s desktop, these documents became inaccessible. This 

upgrade is not the same. To manage a successful move to the .docx format, we recommend the following 

three-pronged approach: 

 Rebuild templates before migration, do not just convert 

 Convert precedent, boilerplate, ―top-drawer‖  or model documents in bulk at time of deployment 

 Convert other documents as needed 

Templates and precedents are often the basis for new documents; proper attention and migration of this 

essential work product is a best practice for ensuring the firm’s reputation and documents stand the test 

of time. Focusing in this area positions the firm for a smoother and quicker adoption of the new file 

format and reduces eleventh-hour emergencies in the future.  
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Rebuild Templates 
Recreate only the Word templates that are moving 

forward by rebuilding them in the .dotx or .dotm 

formats (e.g., .dotm formats are required for all macro-

enabled templates). Using this method, new documents 

start as .docx, allowing you to leverage the benefits of 

OpenXML and new Word features– regardless of your 

Day 1 file format. This is recommended even if you 

decide to initially deploy with .doc as your default. 

Convert Precedent, Boilerplate, “Top-

Drawer” or Model Documents 
Precedents, boilerplate, ―top-drawer‖ or model 

documents are similar to templates in that they are 

frequently used as the starting point for new work 

product.  Thus, just as you plan to upgrade your 

templates, you should also convert your precedent 

library to the .docx format. 

Convert Other Documents as Needed 
Since most documents residing in the DMS remain there untouched and unused, converting them all in 

bulk is not necessary except in unusual circumstances. We recommend converting documents on an ad-

hoc basis. However, asking users to rely on native Word functionality alone to upgrade documents 

requires considerable training to ensure proper template changes are applied, and is subject to risks of 

lost numbering. You can improve conversion rates and reduce document issues by providing users with 

intuitive tools that ensure unwanted issues are not introduced and encourage conversion of these 

documents on an as-needed basis. 

Providing an automated method to promote documents to .docx makes it a part of the user’s standard 

workflow such that they do not have to remember to switch the file type upon saving and ends the 

proliferation of .doc files in use throughout the firm. 

Provide Protection 
When documents are saved to .docx, ensure you protect the document prior to conversion so that you 

can avoid the problems of numbering loss, formatting changes and user confusion. Don’t leave your users 

guessing and trying to muddle through an inefficient workflow. 

DMS 
Not all DMS’ versions support .doc and .docx in the same library or in the same version series. When 

making this decision, ensure you understand your DMS capabilities in both the target and current 

environments.  

  

Rebuild Templates for 

Word 2007/2010  
Step-by- step guidance on how to 

move existing templates is available 

in the ―Rebuild Templates for Word‖ 

Tip under Resources on the 

Microsystems website. In this tip, we 

provide you with steps to ensure 

templates leverage functionality new 

to 2007/2010 while efficiently 

bringing forward investments in 

your current document and 

template designs. 

http://www.microsystems.com/resources/wordtips/wordtip063.php
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Don’t Forget Client Service During the Transition 
Your legal teams may be unaware of how they may jeopardize relationships by not recognizing their 

client’s preferred or default file format. Changing file formats throughout collaboration is a bad practice 

and often leads to document issues. Training on how to recognize their client’s default format is a good 

first step toward minimizing client frustration; having an intuitive workflow that supports both .doc and 

.docx and is easy to follow, closes this loop. Avoid depending on the Compatibility Pack to convert 

documents. If your client prefers .doc, create that document in .doc format from the start or convert it for 

them using Word 2010 or 2007.  

When collaborating with a client, you need awareness, at all levels of the firm, regarding their 

choice of file format. This requires education, checks or tools and training for your lawyers and 

secretaries. 

If your client provides you with a .doc file during a collaboration cycle, return to them either a .doc or PDF 

file, even if your standard is .docx. Not only does this provide your client with a document format that 

they are comfortable with, but it also shows that your organization is flexible and cognizant of your 

client’s needs. Even if they provide you with a .docx file, be aware of the version of Word they are using—

2010 or 2007— and not leverage features in a version of Word that is not supported by your client’s 

environment. 

Client Service Caution if Remaining in .doc 
What if you decide not to move forward with .docx format?  For firms remaining in .doc, an extra element 

of caution is warranted. As your lawyers receive client documents in .docx they risk disabling features and 

functionality enabled by their client. The firm may be perceived as ―behind the times‖ by your clients. Your 

organization may frustrate clients already working with Word 2010 and reaping its benefits, as they 

cannot use the new features when they are dealing with your organization. You also may increase your 

risk of inadvertent negative impacts to your document (,e.g. losing track changes) inherent in the 

Compatibility Packs. Documents received in .docx format should stay that way and vice versa.  

Repercussions of Ignoring .docx  
Some shortcuts, at first blush, may seem to be easier options. You can leave your format as .doc, for 

example, or change your format to .docx and use native Word capabilities to upgrade documents. The 

effect of choosing these shortcuts may result in a delayed project, angry users and dissatisfied clients due 

to: 

Document corruption or formatting changes ð Without proper planning for and attention to the 

possible problems created when saving older documents up to the .docx format, you will have fire drills 

whenever a user’s document is negatively affected. Or worse, your client finds the problem! 

Perpetuation of the .doc format forever ð It is common practice for lawyers to start a new document by 

reusing a previous document that contains their best work. Without a major training initiative or 

automation, users save the new version of the document with the same file format as the original 

document. Unless this habit is broken, .doc documents not only remain in the DMS, but proliferate. Savvy 

clients may perceive this as outmoded even though your firm may, in fact, be technically more 

progressive. In addition, your users will miss out on the advantages of adopting the .docx file formats for 

these documents (see Appendix A). 
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Not Upgrading? 
Even if you are not upgrading to Office 2010 or 2007 or you plan to remain in the .doc format, you can’t 

hide from the changes that are taking place around you and believe you are protected from risks. You can 

protect your firm by preparing your documents for a move to .docx thus preventing the issues that may 

arise as your .doc documents are saved as .docx by your clients or opposing counsel.  

You can remediate these issues by ensuring that your users have a way to protect their documents against 

these problems and avoid exposing the client to the problem. 

Summary 
The .docx format provides many benefits, but without adequate planning, a move to the new file format 

may cause significant challenges and risk negatively impacting clients. 

Whether you adopt a day 1 strategy for .docx as the default, or stay with the .doc format for a period of 

time, you should arm your users with the workflow, tools and training to manage documents in both file 

formats. The .doc (or binary) format remains a part of collaboration, but with proper planning, you can 

minimize the risks and increase the rate of .docx (or OpenXML) adoption. 

Help your lawyers succeed by empowering them with the knowledge and tools to identify and work with 

the file format preferred by their clients. If the client’s preferred file format is unknown, prepare your 

documents for a trip up or down, depending on your default. Eleventh-hour nightmares are preventable 

with planning and careful consideration of the .docx file format.  

How Microsystems Helps 

THE Document Experts 
The potential for lost numbering in a document going from .doc to .docx may be a new revelation for you, 

but we triaged the first known occurrence in 2006. Microsystems DocER service is at the forefront of 

identifying and fixing document issues for over 300 clients with 4,000 documents per year seeking our 

help. This analysis drives innovation throughout our products and services. 

In 2010, we ran a series of conversion tests on over 25,000 typical client documents to surface potential 

problems. We identified and reported to Microsoft several requests for bug fixes related to numbering 

restarts and lost numbering and we developed a new DocXtools module, the doc to docx Module to fix 

these problems and improve user workflow. To date, we have identified 14 problems and have developed 

solutions, or at a minimum a warning, to assist users in either fixing the problem or making an informed 

decision prior to upgrading a document to .docx. 

The doc to docx Module is architected to be easily updated with new solutions for yet to be uncovered 

problems. It is difficult for an individual firm or organization to perform the type of broad analysis that we 

continue to conduct, but as THE document experts, we are compelled to know what might go wrong 

before you do. 
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doc to docx Module 
The intuitive ―Upgrade to .docx‖, ―Downgrade to .doc‖ and ―Upgrade Ready‖ functionality ensures safe, 

secure collaboration and a clear pathway between both formats. Documents are protected from 

unwanted changes and client relationships aren’t jeopardized over core competency requirements. 

Document Conversion Services 
You can use this migration moment as an opportunity to update frequently used documents. By using our 

conversion services, you can: 

 Upgrade precedent, boilerplate or ―top-drawer‖ documents to .docx 

 Apply firm styles to document collections received during a merger or lateral hire 

 Update firm styles to meet new branding initiatives 

 Replace legacy templates and normal.dot 

DocXtools 
Microsoft Word, although feature rich, is not an out-of-the-box comprehensive solution for the highest 

quality, complex documents typically produced by A-rated law firms. Hundreds of the world’s most 

profitable law firms use DocXtools, a combination of software, support and services, to improve the 

efficiency with which their lawyers and support staff draft legal work product. In fact, those law firms who 

have conducted internal studies have reported time savings using DocXtools in excess of 80%. An easy 

and quick resolution to both common and uncommon document issues is often just one-click away for 

the DocXtools customer. 

DocER 
The DocER— Microsystems Document Emergency Room— can handle all kinds of emergencies. Our 

skilled team fixes over 4,000 of our customers' documents annually, and then takes the knowledge gained 

and rolls it into our products to serve you better. Enhancements to our doc to docx Module, for example, 

originated in the DocER. Here are some of the typical emergencies we see: 

 Migration difficulties to/from other versions of Word 

 Numbering failures concerning outlines, single lists and/or bullets 

 Formatting inconsistencies 

 Comparison issues with DeltaView, Workshare Professional and native Word 

 Printing problems 

 Table Formatting problems 

This service is included with your DocXtools subscription. 

Ribbon Design, It’s Not Out-of-the-Box 
In Office 2010, you can add, hide or alter the location of existing Microsoft functionality, custom macros 

and some third-party functionality, but there are design limitations that prevent you from maximizing the 

Ribbon real estate and user workflow. 

Many firms are discovering that this functionality is basic, limited and unintended for the complex 
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modifications that effectively address the needs of the legal community. Using the DocXtools Ribbon 

Designer has the added benefits of defining the type and size of buttons along with drop-down menus 

and groups of functionality that are displayed dynamically.  

Microsystems Compare Ribbon is an example of how DocXtools not only extends Microsoft functionality, 

but also makes it come to life in a dynamic Ribbon supportive of the user’s workflow. 

When designing Ribbons it is important to appreciate the user’s home use of Office and avoid confusion 

by changing or removing common core functionality. On the other hand, many users in a law firm require 

easy access to very specific and often complex functionality. With proper Ribbon design, you can improve 

user efficiency and reduce the training burden. 

Office 2007/2010 Planning Engagement 
Microsystems has helped guide the planning and deployment of Office 2007 and Office 2010 at dozens of 

the world’s leading law firms. The Office Planning Engagement unlocks the keys to achieving the 

improved user experience that is critical to your deployment’s success, through informed design, 

definition and planning. 

About Microsystems 
Microsystems software and services drive document quality and production efficiency while reducing the 

risks associated with collaboration.  

Specifically, DocXtools enhances the productivity of expert and non-expert Microsoft Word users by 

extending the application’s compare, cross reference, style, numbering and table of contents functionality 

and providing automation to identify and correct document issues. To reduce risk, in addition to 

DocXtools, Microsystems offers a technologically advanced metadata solution that prevents leakage from 

the burgeoning use of mobile devices as well as from the desktop. 

Since 1995, Microsystems software and services have improved a law firm’s ability to exceed client 

expectations by allowing them to deliver the highest quality work product—safely and efficiently. 

Contact Us 
Learn how Microsystems clients are maximizing the Word environment for their lawyers, secretaries, legal 

assistants and Word experts. Call 630.598.1100 or e-mail info@microsystems.com to learn more. 

mailto:info@microsystems.com?subject=Making%20Word%20Work%20for%20Legal
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Appendix A 
The advantages of adopting the .docx, .xlsx and .pptx file formats include the following: 

 XML files are compressed making them up to ten times smaller than the same file in a binary format. 

Large documents require less space in your DMS and reduce the time it takes to perform backups. The 

smaller file size also processes through email faster. 

 Due to the file structure, an XML file with one corrupt item may still be opened without losing the entire 

document.  

 Integration for your developers is simpler since the XML file allows access to specific contents within 

the file (e.g., track changes) without having to parse the entire document. 

 Without being in the new format, users  still get the new ribbon, but a number of features are greyed 

out/disabled including: 

 Text Effects on the Home tab, Content Controls on the Developer tab, Tracked Moves from the Track 

Changes Options drop-down on the Review tab, and, on the Insert tab, Themes and the Equation 

Editor. 

 The Bibliography, Citation, Charting and SmartArt features, while not disabled, present legacy 

features far less functional than those in 2010 or 2007. 

 It is easier to incorporate information from different Office documents into a single presentation 

allowing increased re-use and less re-entry. 

 Enables the use of co-authoring features in SharePoint and document editing available via Office Web 

Apps. 
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